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2 LANDASAN TEORI 

2.1 Manajemen Konstruksi 

Manajemen proyek adalah kegiatan merencanakan, mengorganisasikan, 

memimpin, dan mengawasi sumber daya perusahaan untuk mencapai tujuan jangka 

pendek (Soeharto, 1999).  Pengertian lain dari manajemen proyek diantaranya 

manajemen proyek adalah suatu cara atau sistem untuk mengelola berbagai tugas 

perusahaan selama waktu tertentu. Untuk mencapai tujuan tersebut, banyak 

parameter yang harus dilakukan, termasuk manajemen anggaran, sumber daya, tim 

proyek, dan operasional kerja (Aziz et al., 2022).  

Menurut syarif (2011) dalam (Syaputra, 2019) menjelaskan bahwa 

manajemen konstruksi mempunyai beberapa fungsi diantaranya: 

1. Menjaga quality control dalam menjaga kesesuaian antara perencanaan dan 

pelaksanaan. 

2. Mengantisipasi perubahan kondisi lapangan yang dapat berubah-ubah dan 

mengatasi kendala keterbatasan waktu pelaksanaan. 

3. Memantau kemajuan proyek yang telah dicapai dengan laporan harian, 

mingguan dan bulanan. 

4. Hasil evaluasi dapat dijadikan tindakan pengambilan keputusan pada 

masalah-masalah dilapangan. 

5. Menjadi sistem informasi yang baik dalam menganalisis performa 

dilapangan. 

2.2 Biaya Proyek Konstruksi 

Biaya yang harus dikeluarkan untuk membangun sesuatu, seperti rumah atau 

gedung, disebut biaya konstruksi. Biaya ini sangat penting dalam proyek 

konstruksi, seperti yang ditekankan oleh Soeharto (1995). Kita harus hati-hati 

mengatur pengeluaran agar tidak melebihi anggaran yang sudah ditentukan. 

Menurut para ahli dari American Association of Cost Engineering (AACE) (1992), 

biaya konstruksi terdiri dari dua bagian utama. Pertama, biaya yang langsung
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berhubungan dengan pembangunan, seperti membeli bahan bangunan. Kedua, 

biaya yang tidak langsung, seperti biaya sewa alat atau gaji pengawas. 

2.2.1 Biaya Langsung 

Biaya langsung adalah semua biaya yang secara langsung terkait dengan 

aktivitas pembangunan di lapangan (Hartanto, 2021). Beberapa komponen utama 

dari biaya langsung ini meliputi: 

1. Biaya bahan: Meliputi seluruh pengeluaran untuk material yang digunakan 

dalam proyek, mulai dari pembelian hingga pengiriman, termasuk pajak 

dan biaya tambahan lainnya. Perhitungan biaya ini umumnya didasarkan 

pada analisis harga satuan material. 

2. Upah tenaga kerja: Biaya yang dikeluarkan untuk membayar pekerja yang 

terlibat dalam proyek. Besaran upah biasanya ditentukan berdasarkan 

satuan pekerjaan tertentu dan mengacu pada standar upah yang berlaku. 

3. Biaya peralatan: Cakupan biaya ini meliputi sewa, pembelian, perawatan, 

dan operasional peralatan konstruksi. Faktor-faktor seperti biaya 

transportasi peralatan, upah operator, serta biaya depresiasi juga perlu 

dipertimbangkan. 

Estimasi biaya langsung dalam proyek konstruksi dapat dilakukan dengan 

menghitung volume pekerjaan yang direncanakan dan mengalikannya dengan 

harga satuan pekerjaan yang berlaku. 

2.2.2 Biaya Tidak Langsung 

Selain biaya langsung yang terkait langsung dengan pembangunan fisik 

suatu proyek, terdapat pula biaya-biaya tambahan yang tidak secara langsung 

berhubungan dengan konstruksi namun tetap menjadi komponen penting dalam 

keseluruhan biaya proyek. Biaya-biaya ini sering disebut sebagai biaya tidak 

langsung, biaya tidak langsung diantaranya adalah:  

1. Biaya Overhead  

Menurut Cilensek (1991) dalam (Hartanto, 2021), mendefinisikan 

bahwa biaya overhead sebagai berbagai pengeluaran yang mendukung 

kelancaran proyek secara keseluruhan, namun tidak dapat dibebankan 
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secara langsung pada suatu item pekerjaan spesifik. Biaya overhead secara 

umum dapat dikelompokkan menjadi dua kategori utama:  

a. Overhead Kantor  

Overhead Kantor merupakan alokasi beban dari kantor pusat kepada 

proyek. Dimana biaya overhead kantor pusat adalah biaya-biaya yang tak 

langsung terlibat pada proyek konstruksi yang terdapat pada kantor pusat, 

yang dibebankan ke tiap proyek dengan suatu tingkat pembebanan 

tertentu (Taylor, 1994), misalnya: 

1) upah staf/pegawai kantor; 

2) biaya perlengkapan kantor;  

3) listrik; 

4) dan komunikasi (telepon, fax); 

5) sewa kantor dan fasilitasnya; 

6) ijin-ijin usaha; 

7) biaya tender;  

8) referensi bank; 

9) anggota assosiasi. 

b. Overhead proyek (dilapangan) 

Overhead proyek merupakan biaya yang timbul langsung di lokasi 

proyek namun tidak dapat dibebankan pada suatu item pekerjaan tertentu,  

diantaranya adalah:  

1) Biaya personil di lapangan;  

2) Fasilitas sementara proyek seperti biaya untuk pembuatan 

gudang, kantor, penerangan, komunikasi (telpon), transportasi;  

3) Peralatan kecil yang umumnya habis / terbuang setelah proyek 

selesai; 

4) Foto-foto dan gambar jadi (asbuilt drawing);  

5) Rapat-rapat di lapangan;  

6) Biaya-biaya pengukuran, dan lain lain.  

Menurut Minkarah & Ahmad (1998) dan Hesami & Lavasani (2014), 

dalam (Hartanto, 2021) Sejumlah variabel dapat memengaruhi besarnya 

biaya overhead suatu proyek. Dari sisi teknis, kompleksitas desain, metode 
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konstruksi, dan durasi proyek sangat berpengaruh. Faktor lingkungan 

seperti lokasi, kondisi ekonomi, dan regulasi juga turut berperan. Selain itu, 

faktor bisnis seperti persaingan, keuangan kontraktor, dan jenis kontrak 

turut memengaruhi biaya. 

Lalu, Menurut (Hartanto, 2021), Faktor utama yang paling 

mempengaruhi biaya overhead proyek adalah:  

a) Banyaknya/jumlah proyek konstruksi yang tersedia  

apabila proyek konstruksi yang ditender pada saat itu sedikit, maka 

rekanan/ kontraktor akan berusaha menurunkan biaya overhead 

sampai batas minimal.  

b) Kompleksitas proyek  

dengan semakin mudah tingkat kesulitan proyek biaya overhead pun 

semakin kecil.  

c) Pengalaman dalam mengerjakan proyek sejenis  

apabila kontraktor telah berpengalaman dalam mengerjakan proyek 

sejenis, maka kontraktor tersebut semakin tahu strategi dalam, 

melaksanakan proyek tersebut, hal ini akan berpengaruh terhadap 

biaya overhead.  

d) Jumlah kontraktor yang berminat  

apabila kompetitor atau pesaing dalam tender banyak, maka rekanan 

akan berlomba-lomba untuk mendapatkan proyek dengan 

menurunkan harga tawaran yang salah satunya dengan menurunkan 

nilai overhead.  

e) Beban pelaksanaan pekerjaan saat ini (jumlah proyek yang sedang 

dikerjakan)  

jika pada saat tender dilakukan dan rekanan belum memiliki 

pekerjaan yang sedang dilakukan maka, kontraktor akan berusaha 

agar bisa memperoleh pekerjaan atau proyek tersebut.  

f) Kebutuhan kontraktor terhadap pekerjaan/proyek  

Setiap kontraktor pasti butuh terhadap pekerjaan/proyek karena 

dengan adanya pekerjaan maka kelangsungan perusahaan akan tetap 

berjalan.  
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g) Tingkat kesulitan di lokasi (site layout)  

Tingkat kesulitan dilapangan akan berdampak dengan munculnya 

biaya-biaya tak terduga, sehingga akan berpengauh terhadap biaya 

overhead.  

h) Lokasi proyek  

Lokasi Proyek atau lokasi pekerjaan akan sangat mempengaruhi 

biaya pelaksanaan termasuk biaya overhead, karena tingkat 

kesulitan dalam pelaksanan pekerjaan salah satunya adalah lokasi 

dimana kita berkerja.  

i) Lingkungan sekitar atau daerah proyek  

Lingkungan proyek sangat berdampak dalam kelancaran 

pelaksanaan proyek, terutama akses dan dukungan masyarakat 

sekitar, hal ini yang mempengaruhi biaya tak terduga.  

j) Kedaan ekonomi di daerah lokasi proyek  

Kondisi ekonomi didaerah lokasi pekerjaan akan berpengaruh 

terhadap biaya tak terduga.  

k) Ketersediaan kas/keuangan kontraktor  

Dengan tersedianya kas/keuangan perusahaan akan mudah untuk 

memulai pekerjaan tanpa harus menunggu uang muka terebih 

dahulu, sehingga dalam pengadaan material dan lain lain lebih 

mudah, hal ini akan menekan biaya tak terduga dan biaya overhead. 

2. Biaya Tak Terduga/contigencies  

Biaya tak terduga adalah alokasi dana untuk menghadapi berbagai 

kemungkinan yang tidak dapat diprediksi selama proyek berlangsung. 

Mulai dari perubahan kondisi tanah yang tak terduga, seperti naiknya muka 

air tanah atau longsor, hingga kesalahan perhitungan dalam pelaksanaan. 

Menentukan besaran biaya ini cukup menantang karena sifatnya yang 

sangat fluktuatif. Umumnya, alokasi dana contingencies berkisar antara 

0,5% hingga 5% dari total biaya proyek.  

3. Keuntungan / profit  

Keuntungan merupakan daya tarik utama dalam bisnis kontraktor. Ini 

adalah kompensasi yang wajar atas risiko, keahlian, dan usaha yang telah 
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dikeluarkan. Keuntungan berbeda dengan gaji karena keuntungan bersifat 

fluktuatif dan dipengaruhi oleh berbagai faktor, termasuk tingkat 

persaingan. Biaya-biaya proyek umumnya bersifat tetap dan sulit untuk 

dikurangi secara signifikan. Akibatnya, keuntungan menjadi satu-satunya 

komponen yang dapat disesuaikan untuk memenangkan tender. Dalam 

upaya untuk mendapatkan proyek, kontraktor seringkali bersedia 

mengorbankan sebagian keuntungan demi mendapatkan kontrak. 

2.3 Penjadwalan Proyek 

Penjadwalan proyek adalah penentuan jumlah waktu yang tersedia untuk 

menyelesaikan setiap tugas dalam rangka menyelesaikan proyek dengan cara yang 

paling efisien sambil mempertimbangkan keterbatasan dilapangan. Penjadwalan 

dilakukan setelah berbagai masalah muncul dalam proyek. 

Selalu ada proses monitoring dan updating untuk mendapatkan penjadwalan yang 

paling realistis agar alokasi sumber daya dan penentapan durasi sesuai dengan 

sasaran dan tujuan proyek (Azizah, 2017). 

Menurut (Azizah, 2017) penjadwalan proyek mempunyai tujuan diantaranya: 

1. Mempermudah perumusan masalah proyek. 

2. Menentukan metode yang sesuai. 

3. Kegiatan lebih lancar dan terorganisir. 

4. Mendapat hasil yang optimum. 

Penjadwalan mempunyai manfaat diantaranya: 

1. Mengetahui hubungan antar kegiatan. 

2. Mengetahui kegiatan pada waktu/jalur kritis. 

3. Mengetahui mulai dan selesainya suatu kegiatan. 

2.4 Work Breakdown Structure (WBS) 

Work Breakdown Structure (WBS) adalah pemecahan pekerjaan besar 

menjadi pekerjaan-pekerjaan yang lebih kecil dengan tujuan untuk mempermudah 

penjadwalan proyek dan estimasi ongkos serta penentuan yang penanggung jawab 

(Fazis, 2022). WBS adalah pemecahan kegiatan dari total scope of work yang 
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dilakukan oleh tim proyek untuk mencapai tujuan proyek dan membuat kebutuhan 

pekerjaan menjadi mungkin untuk dilakukan (Project Management Institute, 2021). 

Setiap penurunan level dari pemecahan WBS menggambarkan peningkatan 

detail pada pekerjaan proyek. Tingkat terendah dari aktivitas pada WBS disebut 

work package. Work package berguna untuk mengelompokan aktivitas dimana 

pekerjaan dijadwalkan dan diperkirakan, dikontrol, dan diawasi. Pembuatan WBS 

diselesaikan dengan memberikan akun kontrol pada setiap work package. Setiap 

akun kontrol memiliki akses pada informasi biaya, jadwal, dan sumber daya untuk 

work package-nya, akun kontrol juga dapat menambahkan satu atau lebih pekerjaan 

atau biasa disebut planning package pada work package. Planning package adalah 

bagian dari WBS dibawah akun kontrol yang diketahui pekerjaannya, namun tidak 

memiliki jadwal pekerjaan yang rinci(Project Management Institute, 2013). 

Menurut (Fazis, 2022) terdapat 3 manfaat utama dari WBS, yaitu: 

1. Selama analisis WBS, manajer fungsional dan personal lainnya terlibat untuk 

membantu memastikan akurasi dan kelengkapan pekerjaan serta komitmen 

terhadap proyek. 

2. WBS menjadi dasar dalam penganggaran dan penjadwalan. 

3. WBS menjadi alat kontrol pelaksanaan proyek, dimana pekerjaan yang 

dilakukan dapat dibandingkan dengan WBS ini. 

Perencanaan WBS dapat menjadi dasar dalam pendefinisian pekerjaan 

sebagai bagian dari tujuan proyek dan menetapkan struktur untuk mengelola 

pekerjaan tersebut hingga selesai. Dalam perancangan WBS terdapat 8 langkah 

yang dapat diikuti (Purwadi, 2016), diantaranya: 

1. Menemukan produk luaran dari proyek 

Setiap aktivitas dalam proyek memilki deliverables (produk luaran) 

tersendiri, fokus utama proyek sebagian besar berasal dari kebutuhan klien. 

2. Buat dan tinjau struktur awal dari Product Breakdown Structure (PBS) 

Dalam tahap ini, teradapat 2 langkah dalam tahap ini, yaitu: 
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1) Membangun PBS. PBS dapat dibuat dalam bentuk grafik garis besar yang 

menunjukan rangkaian produk luaran proyek hingga selesai, dengan  

mengidentifikasi produk luaran yang terpenting berdasarkan level. 

2) Presentasi PBS kepada klien. Pada tahap ini, terjadi persetujuan tentang 

produk luaran proyek antara klien dengan tim proyek. 

3. Rinci PBS 

Dalam tahap ini, melengkapi bagan yang telah dibuat hingga menjadi satu set 

PBS. Pembuatan PBS dilakukan dengan menggunakan 4 level tingkatan dalam 

visual grafik. Level ini memberi informasi untuk mengontrol proyek dan mengelola 

tim proyek. 

4. Mendefinisikan aktivitas proyek 

Dalam fase ini, manajer proyek mendelegasikan otoritas hasil produk luaran 

kepada individu tertentu, dengan tujuan menetapkan aktivitas untuk mengerjakan 

produk luaran tersebut, serta pelaporan status penyelesaian aktivitas tersebut. 

5. Membangun jaringan aktivitas 

Tahap ini, mengaitkan aktivitas-aktivitas yang telah didefinisikan 

sebelumnya dalam WBS process. Diagram jaringan yang dibuat berorientasi waktu 

dan berurutan dengan logis dari aktivitas sebelumnya.  

6. Penugasan sumber daya 

Tahap ini, dilakukan pelengkapan dari jaringan yang telah dibuat dengan 

mengidentifikasi sumber daya untuk setiap aktivitas serta penanggung jawabnya. 

7. Estimasi durasi proyek 

Dalam tahap ini, setiap anggota tim proyek menetapkan waktu yang 

diperlukan untuk menyelesaikan aktivitas yang mereka kerjakan. 

8. Memastikan Project Timeline 

Tahap selanjutnya adalah memastikan bahwa struktur aktivitas yang telah 

dibuat sesuai dengan estimasi durasi pengerjaan proyek serta hubungan predecessor 

dan successor dari setiap aktivitas proyek.  
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2.5 Bar Charts 

Bar charts atau gantt charts merupakan rencana kerja yang banyak digunakan 

karena sederhana, mudah dibuat dan mudah dimengerti pengguna. Bar charts 

adalah daftar kegiatan yang disusun dalam kolom vertikal dengan kolom 

horizontalnya menunjukan waktu. Durasi kegiatan digambarkan dengan panjang 

diagram batang sehingga mulai dan akhir kegiatan dapat jelas terlihat. Menurut 

(Wulfram I., 2006) terdapat beberapa langkah untuk membuat bar charts, yaitu: 

1. Membuat daftar kegiatan. 

Daftar kegiatan berisi seluruh jenis kegiatan pekerjaan rencana dalam proyek. 

2. Mengurutkan kegiatan. 

Dari daftar kegiatan yang telah dibuat, diurutkan berdasarkan urutan prioritas 

kegiatan yang akan dilaksanakan dahulu dan yang akan dilakukan setelahnya, serta 

terdapat juga kemungkinan dilaksanakan bersamaan. 

3. Menghitung waktu pelaksanaan kegiatan. 

Seluruh kegiatan dari awal hingga akhir dihitung waktu pelaksanaannya. 

Waktu perlaksanaan didapat dari penjumlahan waktu untuk menyelesaikan setiap 

pekerjaan.  

 

Gambar 2.1 Bar Charts 

2.6 Kurva S 

Kurva S adalah grafik hubungan antara kemajuan pelaksanaan proyek dengan 

waktu penyelesaian. Menurut (Hafnidar, 2016) terdapat beberapa aturan-aturan 

dalam membuat kurva s yang harus dipenuhi yaitu: 
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1. Pada 25% waktu pertama grafiknya naik landai hingga 10%. 

2. Pada 50% waktu, grafik naik terjal hingga 45%. 

3. Pada 75% waktu, grafik naik terjal hingga 82%. 

4. Pada waktu terakhirnya, grafik naik landai hingga 100%. 

 

Gambar 2.2 Kurva S 

Masih menurut (Hafnidar, 2016), terdapat beberapa kelebihan dari Kurva S 

dan Bar Charts diantaranya: 

1. Mudah membaca waktu mulai dan selesainya kegiatan. 

2. Memberikan informasi pelaksanaan pekerjaan tersebut lebih cepat, normal 

atau terjadi keterlambatan pada proyek. 

3. Memberi informasi persentase pekerjaan yang telah selesai. 

Sedangkan kelemahan dari Kurva S dan Bar Charts diantaranya: 

1. Tidak memberikan rincian pekerjaan seperti susunan pekerjaan dilapangan. 

2. Tidak memberikan informasi hubungan ketergantungan antar kegiatan. 

3. Tidak adanya informasi tentang kegiatan yang berada pada jalur kritis. 

2.7 Network Planning 

Gray dan Larson (2006) mendefinisikan network planning adalah alat untuk 

merencanakan, menjadwalkan dan mengendalikan kemajuan suatu proyek. 

Network planning/diagram jaringan adalah metode yang dianggap mampu 

menyuguhkan Teknik dasar dalam menentukan urutan dan waktu kegiatan, yang 
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pada giliran selanjutnya digunakan untuk memprediksi waktu selesai proyek secara 

keseluruhan(Wahyudi, 2011). Dari banyaknya variasi analisis jaringan kerja, 

terdapat beberapa metode yang paling umum digunakan yaitu Critical Path Method 

(CPM), Project Evaluation and Review Technique (PERT), dan Precedence 

Diagam Method (PDM). Jika CPM dan PERT digambarkan dengan activity on 

arrow (AOA) maka PDM digambarkan dengan activity on node (AON) (Soeharto, 

1999). 

Gray dan Larson (2006) menyebut beberapa istilah dalam membangun 

diagram jaringan proyek, diantaranya: 

1. Aktivitas, yaitu suatu elemen yang memerlukan waktu. 

2. Aktivitas gabungan, yaitu aktivitas yang memiliki lebih dari satu kegiatan 

yang mendahului. 

3. Aktivitas pararel, yaitu aktivitas yang berjalan bersamaan dengan aktivitas 

lain. 

4. Jalur, yaitu urutan berbagai aktivitas yang saling berhubungan dan tergantung 

satu sama lain. 

5. Predessesor, yaitu aktivitas pendahulu. 

6. Successor, yaitu aktivitas pengganti atau yang mengikuti. 

7. Jalur kritis, yaitu jalur terpanjang pada jaringan. Jika satu aktivitas tertunda, 

otomatis proyek juga tertunda pada waktu yang sama. 

8. Aktivitas menggelembung, yaitu aktivitas ini mempunyai lebih dari satu 

aktivitas yang mengikuti. 

9. Event, yaitu istilah penunjuk satu titik waktu dimana suatu kegiatan dimulai 

atau selesai. 

2.7.1 Activity on Arrow (AOA) dan Activity on Node (AON) 

Activity on Arrow (AOA) adalah diagram kerja dengan tanda anak panah 

yang digambarkan mewakili aktivitas yang dilakukan. AOA mudah untuk 

menggambarkan waktu mulai dan akhir dan AOA juga dapat menujukan urutan dari 

awal hingga akhir merupakan keunggulan dari AOA.  

Jika CPM dan PERT digambarkan dengan activity on arrow (AOA) maka 

PDM digambarkan dengan activity on node (AON). (Soeharto, 1999) Activity on 
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Node (AON) adalah diagram kerja yang memiliki simpul-simpul yang 

menggambarkan aktivitas yang dikerjakan. Keunggulan dari AON yaitu tidak 

memerlukan penggunaan dummy.  

Perbandingan dari Activity on Arrow (AOA) dan Activity on Node (AON) 

dapat dilihat pada Tabel  2.1 dibawah. 

Tabel  2.1 Perbedaan AON dan AOA 

Activity on Node (AON) Keterangan Activity on Arrow (AOA) 

 

Kegiatan D tidak bisa 

berjalan jika A dan B 

belum selesai keduanya, 

sedangkan kegiatan C 

tidak bisa berjalan jika B 

belum selesai. Pada 

AOA dummy digunakan 

pada kegiatan A. 

 

 

Kegiatan A dan B harus 

selesai sebelum 

dimulainya C. 

 

 

Kegiatan B dan C tidak 

bisa berjalan jika A 

belum selesai. 

 

 

Kegiatan C dan D tidak 

bisa berjalan jika 

kegiatan A dan B belum 

selesai keduanya. 
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Activity on Node (AON) Keterangan Activity on Arrow (AOA) 

 

Kegiatan B dan C tidak 

bisa berjalan jika A 

belum selesai. Kegiatan 

D hanya dapat berjalan 

jika B dan C selesai. 

Pada kegiatan A dalam 

AOA Kembali 

digunakan dummy.  

 

Sumber: (Soeharto, 1999) 

2.8 Critical Path Method (CPM) 

Critical Path Method (CPM) T.Hani Handoko mengatakan CPM adalah 

metode untuk mengoptimalkan biaya proyek dengan menetapkan waktu dan 

pertukaran biaya untuk memenuhi jadwal proyek dan mengurangi biaya. Dengan 

CPM, jumlah waktu yang dibutuhkan untuk menyelesaikan berbagai tahap proyek 

dianggap jelas, dan hubungan antara jumlah sumber yang digunakan dan waktu 

yang diperlukan untuk menyelesaikan proyek juga diketahui (Bangun, 2016).  

Dalam CPM, dikenal istilah jalur kritis dan dummy. Jalur kritis adalah 

jaringan kerja yang memiliki rangkaian-rangkaian kegiatan dengan total waktu 

terlama dan menunjukan waktu selesai tercepat. Kegiatan-kegiatan yang melewati 

jalur kritis diusahakan tidak terlambat selesai. Apabila kegiatan pada jalur kritis 

maka proyek akan terlampat secara keseluruhan (Bangun, 2016). 

Terdapat beberapa ciri pada jalur kritis yaitu: 

1) Jalur dengan waktu terpanjang dalam suatu proses. 

2) Jalur tidak memiliki waktu tenggang dari mulai hingga selesai kegiatan. 

3) Tidak ada tenggang waktu tersebut merupakan sifat kritis dari jalur kritis. 

Dummy adalah aktivitas yang tidak mempunyai waktu pelaksanaan dan hanya 

diperlukan untuk menunjukkan adanya hubungan di antara dua kegiatan (Bangun, 

2016). Karena dummy adalah kegiatan semu, tidak ada waktu yang dihabiskan 

untuk bekerja. 
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2.9 Project Evaluation and Review Technique (PERT) 

Menurut T. Hari Handoko Project Evaluation and Review Technique (PERT) 

adalah suatu metode analisis untuk membantu dalam penjadwalan dan 

pengendalian proyek-proyek kompleks, dengan masalah utama yaitu masalah 

teknik dalam penjadwalan kegiatan beserta anggaran biayanya sehinnga proyek 

dapat selesai tepat waktu dan biaya. PERT divisualisasikan dengan grafik yang 

mengilustrasikan sebuah proyek (Bangun, 2016). 

Menurut Soeharto, terdapat tiga perkiraan waktu biasanya digunakan untuk 

setiap aktivitas pada metode PERT (Soeharto, 1999), yaitu:  

1) Waktu Optimis (a) adalah perkiraan waktu yang paling singkat untuk 

menyelesaikan aktivitas. 

2) Waktu Perkiraan Paling Mungkin (m) adalah waktu yang memiliki 

kemungkinan tertinggi untuk menyelesaikan aktivitas (berbeda dengan waktu 

yang diharapkan). 

3) Waktu Pesimis (b) adalah perkiraan waktu terpanjang yang mungkin 

diperlukan untuk menyelesaikan aktivitas. 

2.10 Presedence Diagram Method (PDM) 

Menurut Soeharto (1999) Presedence Diagram Method (PDM) adalah 

metode jaringan kerja yang dikenal karena jalur kritis, yaitu jalur dengan rangkaian 

komponen-komponen kegiatan dengan total jumlah waktu terlama dan menunjukan 

kurun waktu penyelesaian proyek tercepat (Soeharto, 1999). PDM merupakan 

pengembangan dari bar chart. Pada tahun 1980-2000 seiring dengan perkembangan 

kemajuan komputer, atribut PDM terus bertambah seperti jenis hubungan, lag, dan 

lead time value pada depensi, beberapa sumber daya pada kegiatan (Oktavia, 2018). 

PDM menjelaskan hubungan seri antara dua kegiatan dengan salah satu 

kegiatan merupakan pengikut dari kegiatan pendahulunya, hubungan ini dikenal 

dengan nama dependances (ketergantungan) dan precendence (yang didahulukan), 

pengaturan ini diutamakan dengan hubungan logika ketergantungan antar kegiatan. 

Pada metode PDM, node digambarkan dengan kotak dengan penghubung 

ketergantungan antar kegiatannya berupa anak panah (arrow). 
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2.10.1 Kontrain / Hubungan Logis 

Pada metode PDM juga dikenal dengan Konstrain/hubungan logis. Pada 

setiap node hanya memiliki satu ujung awal atau mulai (S) dan satu ujung akhir 

atau selesai (F). oleh karena itu, satu konstrain hanya dapat menghubungkan dua 

node (Abidin, 2021). 

Menurut (Soeharto, 1999) terdapat beberapa jenis konstrain diantaranya: 

1. Finish to start (FS)  

Konstrain ini menjelaskan hubungan bahwa mulainya (Start) kegiatan 

berikutnya tergantung pada selesainya (Finish) kegiatan. Konstrain ini dirumuskan 

dengan: 

FS(i − j) = a 

Dimana kegiatan (j) mulai dengan a hari, setelah kegiatan yang 

mendahuluinya (i) selesai. Konstrain ini dapat digambarkan dengan Gambar 2.3. 

 

Gambar 2.3 Hubungan Finish to Start (FS) 

 

 

2. Start to Start (SS) 

Konstrain ini menjelaskan hubungan mulainya (Start) kegiatan berikutnya 

tergantung pada mulainya (Start) kegiatan sebelumnya. Konstran ini dapat 

dirumuskan dengan: 

SS(i − j) = b 

Dimana suatu kegiatan (j) mulai setelah b hari kegiatan terdahulu (i) mulai. 

Dalam konstrain ini, kegiatan (j) boleh dimulai setelah bagian tertentu dari kegiatan 

(i) selesai. Angka b tidak boleh melebihi angka waktu kegiatan terdahulu. Konstran 

ini dapat digambarkan seperti pada Gambar 2.4. 
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Gambar 2.4 Hubungan Start to Start (SS) 

3. Finish to Finish (FF) 

Konstran ini menjelaskan hubungan selesainya (Finish) kegiatan 

berikutnya tergantung pada selesainya (Finish) kegiatan sebelumnya. Konstran ini 

dirumuskan seperti berikut ini: 

FF(i − j) = c 

Dimana suatu kegiatan (j) selesai setelah c hari kegiatan terdahulu (i) 

selesai. Konstran ini mencegah suatu kegiatan selesai sebelum kegiatan terdahulu 

mencapai targetnya (c) selesai. Angka c tidak boleh lebih dari waktu kegiatan yang 

bersangkutan (j). Konstran ini dapat digambarkan seperti pada Gambar 2.5. 

 

Gambar 2.5 Hubungan Finish to Finish (FF) 

4. Start to Finish (SF) 

Konstran ini menjelaskan bahwa selesainya (Finish) kegiatan berikutnya 

tergantung pada mulainya (Start) kegiatan sebelumnya. Dimana dirumuskan seperti 

berikut: 
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SF(i − j) = d 

Dimana kegiatan (j) selesai setelah d hari kegiatan (i) sebelumnya mulai. 

Dengan kata lain, Sebagian dari kegiatan terdahulu harus selesai sebelum kegiatan 

yang bersangkutan selesai. Konstran ini dapat digambarkan seperti pada Gambar 

2.6. 

 

Gambar 2.6 Hubungan Start to Finish (SF) 

2.10.2 Lambang PDM  

Dalam penggunaan metode PDM ini, agar memudahkan untuk 

mengidentifikasi maka digunakan lambang (Wulfram I., 2006). Lambang atau node 

PDM dapat dilihat pada Gambar 2.7. 

 

Gambar 2.7 Lambang Precedence Diagram Method (PDM) 

 

Dimana:  

• ES (Earliest Start) adalah waktu mulai paling awal kegiatan dimulai. 



24 

 

 
 

• EF (Earliest Finish) adalah waktu selesai paling awal kegiatan selesai. Jika 

terdapat satu kegiatan terdahulu, maka EF kegiatan pendahulu adalah ES 

kegiatan selanjutnya. 

• LS (Latest Start) adalah waktu paling lambat dimulainya suatu kegiatan.  

• LF (Latest Finish) adalah waktu paling lambat suatu kegiatan diselesaikan. 

2.10.3 Perhitungan dalam metode PDM 

1. Perhitungan Maju 

Perhitungan ini dilakukan untuk mencari ES dan EF, apabila anak panah 

yang masuk lebih dari satu, maka diambil nilai terbesar. Dalam mencari ES dan EF 

digunakan rumus: 

ES = EF − Durasi atau EF = ES + Durasi 

2. Perhitungan Mundur 

Perhitungan ini dilakukan untuk mencari LS dan LF, apabila anak panah 

yang masuk lebih dari satu, maka diambil nilai terkecil. Rumus yang digunakan 

yaitu: 

LS = LF − Durasi atau LF = LS + Durasi 

3. Perhitungan Total Float 

Float adalah batas toleransi keterlambatan suatu kegiatan yang dapat 

dimanfaatkan untuk optimalisasi waktu dan alokasi sumber daya(Abidin, 2021). 

Terdapat dua jenis float, diantaranya: 

• Total Float (TF) 

Total float yaitu waktu yang dapat digunakan untuk menunda suatu 

kegiatan tanpa mengganggu selesainya proyek tepat waktu. Rumus untuk TF yaitu: 

𝑇𝑜𝑡𝑎𝑙 𝐹𝑙𝑜𝑎𝑡(TF) = LF − EF atau LSj − EFi 
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• Free Float (FF) 

Free float yaitu waktu yang dapat digunakan untuk menunda suatu 

kegiatan tanpa mengganggu mulainya kegiatan yang mengikutinya. FF dapat dicari 

dengan rumus: 

𝐹𝑟𝑒𝑒 𝐹𝑙𝑜𝑎𝑡(FF) = ESj − EFi 

2.10.4 Jalur Kritis Metode PDM 

Jalur kritis adalah jaringan kerja yang memiliki rangkaian-rangkaian 

kegiatan dengan total waktu terlama dan menunjukan waktu selesai tercepat. 

Kegiatan-kegiatan yang melewati jalur kritis diusahakan tidak terlambat selesai. 

Apabila kegiatan pada jalur kritis maka proyek akan terlampat secara keseluruhan 

(Bangun, 2016). Jalur kritis metode PDM didapat setelah selesai perhitungan maju 

dan mundur. Jalur kritis memiliki ciri yaitu:  

ES =LS, atau EF = LF, atau LF = ES =Durasi kegiatan, atau TF = 0 

Kelebihan dari metode PDM yaitu metode ini tidak memerlukan dummy, 

karena hubungan overlapping yang berbeda dapat dibuat tanpa menambah jumlah 

kegiatan. Selain itu, hubungan tumpang tindih juga dapat dibuat tanpa menambah 

kegiatan. Sehingga pembuatan jaringan lebih sederhana. Jika kegiatan awal dan 

akhir lebih dari satu, maka pada jaringan digunakan kegiatan dummy awal atau 

akhir. Kelebihan PDM dapat dilihat pada Gambar 2.8. 

 

Gambar 2.8 Precedence Diagram method (PDM) 

2.11 Metode Percepatan Pelaksanaan Pekerjaan (Crash Program)  

Crashing adalah proses merubah metode pekerjaan yang berpengaruh pada 

durasi penyelesaian proyek. Hal ini dilakukan dengan memperkirakan variable cost 
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agar mengurangi durasi yang maksimal dan ekonomis dari suatu kegiatan yang 

memungkinkan untuk direduksi (Ervianto, 2004). 

Dengan metode crashing, waktu dari suatu pekerjaan dapat dipersingkat 

dengan menambah sumber daya dan biaya langsung. Dalam melakukan proses 

crashing, setiap kegiatan harus memiliki informasi berikut, diantaranya: 

1. Perkiraan biaya setiap pekerjaan dalam situasi normal. 

2. Penyelesaian proyek dalam kondisi percepatan merupakan waktu tercepat 

yang dapat dilakukan di bawah kondisi percepatan. 

3. Perkiraan biaya tenaga kerja dalam kondisi percepatan. 

Dengan melakukan percepatan terdapat beberapa masalah yang mungkin 

muncul diantaranya, biaya yang diperlukan lebih besar dari perencanaan serta 

kualitas yang cenderung lebih rendah. Sebagai contoh, saat dilakukan crashing 

dengan lembur maka upah akan bertambah namun produktivitas tenaga kerja akan 

menurun angkanya.   

Menurut (Frederika dalam Violita, 2020) dalam melaksanakan percepatan 

suatu proyek, terdapat 4 faktor yang bisa dioptimalkan, diantaranya: 

1. Menambah tenaga kerja. 

2. Penjadwalan lembur. 

3. Menambah atau mengganti alat yang lebih produktif. 

4. Mengubah metode pelaksanaan.  

2.11.1 Produktivitas Tenaga Kerja 

Produktivitas adalah perbandingan hasil yang dicapai dengan seluruh 

sumber daya atau perbandingan jumlah produktivitas (input) dengan sumber daya 

yang digunakan (output) (Setiawan dalam Violita, 2020). 

Produktivitas tenaga kerja =
1

Koefisien tenaga kerja
 

Atau 

Produktivitas tenaga kerja =
Volume

Durasi × Jumlah tenaga kerja
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Menurut (Kaming dalam Violita, 2020) terdapat 3 faktor yang 

berpengaruh pada produktivitas, diantaranya: 

1. Metode dan teknologi yang digunakan seperti desain rekayasa, 

metode konstruksi, urutan dan pengukuran kerja. 

2. Manajemen lapangan seperti perencanaan dan penjadwalan, lay 

out lapangan, komunikasi, manajemen material, alat dan tenaga 

kerja. 

3. Faktor manusia seperti upah, kepuasan kerja, insentif, hubungan 

kerja mandor-pekerja, sejawat dan kemangkiran. 

Penurunan produktivitas tenaga kerja akibat jam lembur dapat ditunjukan 

seperti pada Gambar 2.9. 

 

Gambar 2.9 Grafik Indikasi Turunnya Produktivitas Akibat Kerja Lembur 

(Sumber: Soeharto, 1997) 

2.11.2 Penambahan Tenaga Kerja 

Dalam melakukan penambahan tenaga kerja, terdapat beberapa hal yang 

harus diperhatikan yaitu: 

1. Bersedianya pekerja untuk menjadi pekerja tidak tetap.  

2. Produktivitas tenaga kerja akan terjaga.  

3. Kerjasama dalam tim akan berkurang. 

Hubungan waktu-biaya normal serta waktu-biaya pada percepatan, dapat 

dilihat pada Gambar 2.10. Dimana apabila waktu dipercepat, maka biaya yang 

dibutuhkan akan meningkat dari biaya normal akibat peningkatan biaya langsung. 
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Gambar 2.10 Grafik Hubungan Waktu-Biaya Normal dan Dipersingkat 

(Sumber: Soeharto, 1997) 

2.11.3 Penambahan Kerja Lembur 

Metode jam kerja lembur dilakukan untuk mempercepat durasi pekerjaan 

dengan menggunakan rencana kerja sebagai berikut: 

1. Waktu kerja normal adalah 8 jam (08.00-17.00), dan lembur dilakukan 

setelah jam kerja normal. 

2. Upah kerja lembur sesuai KEP.102/MEN/VI/2004 pasal 11 dihitung 

sebagai berikut: 

1) Perhitungan upah lembur berdasarkan pada upah bulanan.  

2) Cara menghitung upah kerja lembur, diantaranya dengan rumus:  

a. Upah jam lembur pertama = 1,5 × upah sejam.  

b. Upah jam lembur kedua dan seterusnya = 2 × upah sejam.  

3) Penambahan jam lembur dalam satu hari hanya boleh 3 jam dan 14 

jam dalam seminggu. 

4) Memberikan makan dan minum minimal 1400 kalori jika lembur 

selama 3 jam. 

Dalam melaksanakan lembur, terdapat hal-hal yang perlu diperhatikan 

yaitu: 

1. Bersedianya pekerja untuk melakukan lembur.  

2. Penurunan produktivitas kerja para pekerja.  

3. Upah harus dibayar lebih tinggi dari upah yang biasa dibayarkan. 

4. Tidak perlu tambahan tenaga kerja.  
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5. Perlu adanya penambahan penerangan karena biasanya lembur diadakan 

sampai malam hari. 

2.12 Oracle Primavera P6 Professional 23 

Oracle Primavera P6 Professional 23 adalah aplikasi untuk mengelola 

proyek konstruksi dengan cakupan yang lengkap, terukur serta terintegrasi dalam 

merencanakan, mengorganisasi serta pengawasan proyek. Aplikasi ini dapat 

digunakan untuk perencanaan penjadwalan waktu, biaya, sumber daya dan tenaga 

kerja untuk proyek besar maupun kecil. Aplikasi ini dikembangkan oleh perusahaan 

Primavera System Inc. yang merupakan perusahaan bidang software manajemen 

konstruksi dengan cakupan yang lengkap dan terintegrasi untuk perencanaan, 

pengorganisasian, pemantauan dan koordinasi (Alif, 2022).  

Penggunaan alat bantu berupa komputer dan aplikasi penunjang dalam 

merencanakan penjadwalan, hal tersebut dapat memberikan manfaat dengan 

meminimalisir terjadinya kesalahan dan mempercepat pengerjaan serta 

meningkatkan ketelitian dalam mengolah data dalam jumlah besar. Keunggulan 

dari penggunaan aplikasi Oracle Primavera P6 Professional 23 diantaranya: 

1. Mengatur informasi proyek dengan kerangka strukturalnya menggunakan 

kode-kode aktivitas, sumber daya serta tanggal. 

2. Memiliki kapasitas hingga 100.000 kegiatan per proyek. 

3. Mampu mengontrol dan membuat jadwal pekerjaan yang kompleks. 

4. Mampu mengendalikan sumber daya dan durasi pada setiap kegiatan. 

5. Bisa menghitung biaya pada setiap jenis pekerjaan dan total proyek. 

6. Mengendalikan biaya dan jadwal proyek. 

Output yang dapat dihasilkan dari mengolahan data pada aplikasi Oracle 

Primavera P6 Professional 23 diantaranya: 

1. Lay Out Gantt Chart (Diagram batang). 

2. Budgeted Cost (Anggaran biaya proyek). 

3. Resource Profile (Profil sumber daya). 

4. Resource Table (Tabel sumber daya). 
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Dalam mendukung kebutuhan manajemen proyek seperti manajemen waktu, 

biaya, sumber daya dan pengelolaan proyek skala besar, Oracle Primavera P6 

Professional 23 dirancang untuk terintegrasi dengan manajemen proyek PPM 

(Portofolio Project Management). Dengan PPM memungkinkan suatu organisasi 

melakukan hal-hal berikut: 

1. Membuat strategi pelaksanaan. 

2. Mengendalikan detail untuk menyelesaikan proyek. 

3. Memahami kebutuhan sumber daya, prioritas serta evaluasi kebutuhan staff 

jangka panjang. 

4. Optimalisasi sumber daya dengan baik dan merata. 

5. Mengendalikan proyek sesuai dengan pergeseran prioritas tanpa 

mengesampingkan kualitas. 

Dalam penggunaan Oracle Primavera P6 Professional 23 terdapat beberapa 

istilah khusus yang harus diperhatikan diantaranya: 

1. Task yaitu lebar kerja pada primavera yang berisi rincian pekerjaan serta 

perintah untuk proses pengelompokan pekerjaan. 

2. Duration adalah waktu yang dibutuhkan untuk menyelesaikan pekerjaan. 

3. Start yaitu tanggal mulainya suatu pekerjaan. 

4. Finish yaitu tanggal selesai suatu pekerjaan. 

5. Predecessor yaitu hubungan keterkaitan antar pekerjaan. 

6. Resource adalah sumber daya material maupun manusia. 

7. Cost yaitu biaya untuk gaji maupun material yang digunakan. 

8. Pert Chart adalah diagram hubungan antar pekerjaan yang digambarkan 

dengan bentuk network diagram. 

9. Baseline yaitu rencana jadwal atau biaya yang telah ditetapkan dan digunakan 

untuk acuan perbandingan rencana dan actual dilapangan. 

10. Hasil Gantt Chart adalah salah satu tampilan hasil kerja yang berupa batang 

horizontal dari masing-masing pekerjaan dengan durasinya. 

11. Tracking yaitu peninjauan hasil dilapangan dengan rencana pada primavera. 

12. Milestone yaitu penanda perkembangan proyek pada suatu posisi pekerjaan 

agar mudah diketahui.  
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Dalam menyusun rencana penjadwalan proyek pada aplikasi Oracle 

Primavera P6 Professional 23, dapat dilakukan dengan mengikuti langkah-langkah 

berikut (Alif, 2022): 

1. Membuka lembar kerja baru 

Langkah pertama dilakukan dengan klik Start > Program > Primavera P6. 

2. Membuat file proyek baru 

Selanjutnya pilih menu File > New > Select EPS > Next > Tentukan tanggal 

mulai proyek pada Project ID > Tentukan nama proyek pada Project Name > 

Next > Tentukan tanggal selesai proyek pada Must Finish By > Next > 

Memasukan nama kepala proyek pada Responsible Manager > Next > Tentukan 

satuan yang digunakan pada Rate Type > Next > Tentukan arsitek digunakan 

atau tidak pada Project Architect > Next > Finish. 

 

Gambar 2.11 Membuat File Project Baru  

(Sumber: Alif, 2022) 

3. Menginput Work Breakdown Structure (WBS) 

Dalam menginput WBS dapat dilakukan dengan buka project yang telah 

dibuat > Buat Work Breakdown Structure (WBS) > Klik menu WBS > Isi 

urutan pekerjaan. 
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Gambar 2.12 Menyusun Work Breakdown Structure (WBS) 

(Sumber: Alif, 2022) 

 

4. Membuat aktivitas hubungan pekerjaan 

Dalam membuat aktivitas hubungan pekerjaan dapat dilakukan dengan 

memilik menu Activities > Mengisi list pekerjaan > Klik (+) untuk menambah 

aktivitas > Menentukan durasi pekerjaan berdasar volume pekerjaan pada 

Original Duration. 

 

Gambar 2.13 Menyusun Aktivitas  

(Sumber: Alif, 2022) 
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5. Membuat hubungan antar pekerjaan 

Hubungan antar pekerjaan pada tab Relationship Finish to Start (FS), Start 

to Finish (SF), Finish to Finish (FF), Start to Start (SS) > Hubungan antar 

pekerjaan berdasarkan gambar kerja > Klik pada aktivitas > tentukan 

Predesessor. 

 

Gambar 2.14 Membuat Hubungan Antar Pekerjaan 

(Sumber: Alif, 2022) 

6. Menyusun kalender kerja 

Tahapan ini dilakukan untuk menentukan hari kerja dan jam kerja. 

Langkahnya yaitu dengan klik menu Tools > Schedule > Option > Schedule 

Automatically when a Change effect dates > Close > schedule. 

 

Gambar 2.15 Menyusun Kalender Kerja 

 (Sumber: Alif, 2022)  


